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The lateral line sensory system in fish detects movements 
in the water and allows fish to respond to predators, prey, 
and other stimuli.  As the lateral line forms in the first two 
days of zebrafish development, axons extend caudally 
along the lateral surface of the fish, eventually forming 
synapses with hair cells of neuromasts.  Growing lateral 
line axons are located superficially under the skin and can 
be labeled in living zebrafish using fluorescent protein 
expression.  This system provides a relatively straight-
forward approach for in vivo time-lapse imaging of 
neuronal development in an undergraduate setting. 
     Here we describe an upper-level neurobiology 
laboratory module in which students investigate aspects of 
axonal development in the zebrafish lateral line system.  
Students learn to handle and image living fish, collect time-
lapse videos of moving mitochondria, and quantitatively 
measure mitochondrial dynamics by generating and 
analyzing kymographs of their movements.  Energy 
demands may differ between axons with extending growth 
cones versus axons that have already reached their targets 
and are forming synapses.  Since relatively little is known 

about this process in developing lateral line axons, 
students generate and test their own hypotheses regarding 
how mitochondrial dynamics may differ at two different time 
points in axonal development.  Students also learn to 
incorporate into their analysis a powerful yet accessible 
quantitative tool, the kymograph, which is used to graph 
movement over time.  After students measure and quantify 
dynamics in living fish at 1 and 2 days post fertilization, this 
module extends into independent projects, in which 
students can expand their studies in a number of different, 
inquiry-driven directions.  The project can also be pared 
down for courses that wish to focus solely on the 
quantitative analysis (without fish handling), or vice versa.  
This research module provides a useful approach for the 
design of open-ended laboratory research projects that 
integrate the scientific process into undergraduate Biology 
courses, as encouraged by the AAAS and NSF Vision and 
Change Initiative. 
     Key words: zebrafish; lateral line; mitochondria; time-
lapse imaging; in vivo; fluorescence; axon development; 
growth cone 

 

 
 
The lateral line is a mechanosensory organ system in 
aquatic vertebrates that detects movement and vibration in 
the water.  Crucial for the animal’s survival, this sensory 
system conveys information needed for proper schooling 
behavior and for locating predators and prey.  The lateral 
line is composed of small clusters of hair cells and support 
cells, together called neuromasts, which are dotted along 
the lateral portion of the head and trunk of the fish (Figure 
1).  The hair cells within each neuromast use stereocilia to 
convert mechanical signals from the water into electrical 
potentials.  Neurotransmitter is then released via synapses 
at the base of the hair cell onto peripheral axons that relay 
information into the central nervous system (reviewed in 
Dambly-Chaudiere et al., 2003; Harding et al., 2013). 
     The lateral line system provides an ideal platform for 
studying mechanisms of axonal development in vivo.  The 
axons that innervate hair cells are long, projecting from the 
lateral line ganglion behind the ear along the length of the 
fish, and undergo a classic pattern of growth and 
maturation (Chitnis et al., 2012) that can be followed over a 
relatively short period of time.  Further, the axons can be 
visualized clearly due to their superficial location along the 
side of the fish (Dambly-Chaudiere et al., 2003). 
     Here we focus on axonal development in the lateral line 
system in zebrafish, an ideal model system for an 

undergraduate research project, in part due to the small 
size of zebrafish, low cost, and transparency during early 
development (Nüsslein-Volhard and Dahm, 2002).  The 
initial phase of posterior lateral line development in 
zebrafish occurs between 20-48 hours post fertilization 
(hpf) (Metcalfe, 1985).  At 20 hpf, a group of cells called 
the posterior lateral line primordium begins migrating from 
behind the embryonic ear toward the tail (Figure 1A-B).  
Clusters of migrating cells are progressively deposited 
along the trunk; each cluster will develop into a neuromast.  
Meanwhile, a group of axonal growth cones, whose cell 
bodies remain stationary behind the ear, are embedded in 
and migrate with the primordium (Metcalfe, 1985; Gilmour 
et al., 2004).  By 48 hpf, the primordium has reached the 
tail and deposited a full set of neuromasts (5-7 total) along 
the length of the trunk.  The axons have also fully extended 
into the tail, innervating newly deposited neuromasts 
(Figure 1C).  The rapid pace of this developmental process 
allows analysis of multiple stages of axonal development 
over a short period of time, including growth cone 
dynamics, axon outgrowth and extension, and target 
arrival. 
     As lateral line axons grow, their rapid extension and the 
highly dynamic remodeling of the actin cytoskeleton at the 
growth cone likely requires a large amount of ATP, as in  
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Figure 1.  Posterior lateral line development during days 1-2 of 
zebrafish development.  A. At around 20 hours post fertilization 

(hpf), a group of cells called the posterior lateral line primordium 
begins migrating caudally from behind the embryonic ear (otic 
vesicle).  B. The primordium continues to migrate at 36 hpf, 

depositing clusters of cells along the trunk that will develop into 
neuromasts.  A group of axonal growth cones are embedded in 
the primordium and extend caudally.  C. By 48 hpf, the 

primordium and axons have both reached the tail.  A group of fully 
extended lateral line axons now form synapses to innervate newly 
deposited neuromasts. 

 
 
other examples of growth cone extension (Lin and Sheng, 
2015).  To meet this high energetic demand, mitochondria 
are continuously transported from their site of synthesis in 
the cell body out along the length of the axon (Morris and 
Hollenbeck, 1995; Ruthel and Hollenbeck, 2003; Maeder et 
al., 2014).  In more mature neurons, a reliable supply of 
peripheral ATP is still required, to support processes such 
as synaptic development, synaptic vesicle cycling, and 
generation of action potentials (reviewed in Sheng, 2014; 
Lin and Sheng, 2015).  Such changing energy demands 
may necessitate changes in mitochondrial transport 
patterns and dynamics during development, but such 
mechanisms are not well understood.  Axons in the 
developing lateral line are well suited to study this 
question. 
     In this research module, students test directly whether 
mitochondrial transport dynamics in the lateral line differ 
within immature growing axons versus fully extended 
axons.  In zebrafish, as posterior lateral line axons extend, 
mitochondria are continually transported in both the 
anterograde and retrograde directions (Drerup and 
Nechiporuk, 2013).  These mitochondria, as well as the 

lateral line axons themselves, are easily labeled in 
zebrafish with fluorescent constructs, and visualized both 
during and after axon extension.  The developing posterior 
lateral line axons lie just underneath the skin of the 
embryo, and the body axis of the embryonic fish is 
relatively flat, making the lateral line in zebrafish 
particularly amenable to time-lapse imaging with a basic 
fluorescence microscope.  By examining mitochondrial 
transport (both anterograde and retrograde) in developing 
zebrafish lateral line axons, students can test predictions 
about the potentially changing characteristics of 
mitochondrial transport dynamics and requirements both 
during and following axon growth in vivo.  Students 
measure, quantify, and compare mitochondrial dynamics in 
lateral line axons at two key stages: ~24 hpf, when the 
axons are still growing and growth cones are still present; 
and ~48 hpf, when the axons are fully extended and 
beginning to form synapses.  Students design their own 
hypotheses regarding the varying requirements for ATP at 
each of these stages, and quantify mitochondrial dynamics 
as an assay for ATP synthesis and delivery.  In addition to 
characterizing wild-type transport, students also have a 
straightforward system in which to address transport 
mechanisms via the application of drug treatments or 
genetic manipulations.  Furthermore, since additional 
neuromasts continue to develop after 2 days post 
fertilization (dpf) (Dambly-Chaudiere et al., 2003), 
additional time points can be added at later stages.  
Kymographic analysis is a powerful quantitative tool that 
undergraduates rarely have an opportunity to generate 
from their own in vivo experiments.  This type of movement 
quantification has broad application to other systems.  
Furthermore, since little is known about the changes in 
mitochondrial dynamics during lateral line development, 
students are pursuing an open-ended research question 
without simply targeting a right or wrong answer. 

 
STUDENT LEARNING 
This module provides students the opportunity to learn a 

number of key skills that they apply to an open-ended 

research question.  These skills include: 1) handling and 

anesthetization of living zebrafish embryos; 2) in vivo time-

lapse fluorescence microscopy that can be done on a basic 

wide-field epifluorescence microscope (or scaled up for 

more powerful systems); 3) quantitative analysis of 

mitochondrial dynamics via generating kymographs to 

measure moving mitochondria in time-lapse movies (an 

approach that can be applied broadly to quantifying motion 

in other types of research projects); 4) quantitative 

comparison of axons at two different developmental 

stages; 5) design and completion of an independent 

research project (optional); and 6) preparation of an oral 

and/or written presentation.  Depending upon the time and 

resources available at the institution, the overall module 

can take anywhere from one week to the entire semester.  

(See Tables 1-2; an incorporation of independent projects 

can branch off from original research project.) The more 

lengthy projects allow students to pursue more open-ended 

and independent research questions. 
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MATERIALS AND METHODS 
We have developed this research project for an advanced 
undergraduate neurobiology laboratory course with an 
enrollment of 15-24 junior and senior students.  As 
designed, it is the main focus of the laboratory portion of 
the class for the semester, taking approximately 10 lab 
sessions to complete; however, it can be scaled up or 
down depending upon time and resources available at the 
institution.  The following sections provide background for 
introducing and conducting this research project with 
students.  Two sample schedules for carrying out the 
project (one full-length, one abbreviated module) are also 
included below. 
 

PRE-LABORATORY PREPARATION 
 

Background 
To begin the research project, students first require some 
background in a number of areas, including zebrafish 
anatomy, lateral line function, axonal development, and 
mitochondrial trafficking.  If some of these topics are 
already covered in the lecture component of a 
lecture/laboratory course, the laboratory is an ideal 
application of what they are learning in the classroom.  
Students also need a prior lab session on microscopy, with 
previous practice using the fluorescence microscopes.  We 
provide all of this background in the laboratory, before the 
project begins.  Teaching materials for these subjects are 
available at weissmanlab.com. 
     If an active local zebrafish facility is not available for 
obtaining embryos, wild-type breeding pairs of zebrafish 
can be acquired from the Zebrafish International Resource 
Center (ZIRC) or from a local pet store (Westerfield, 2000).  
The Tg(neuroD:EGFP line (see below) is also available 
from ZIRC.  A number of useful resources are available 
that describe zebrafish maintenance, mating, and 
microinjection techniques (e.g., Westerfield, 2000).  
Currently, the NIH does not require Institutional Animal 
Care and Use Committee (IACUC) protocols for zebrafish 
3 dpf or younger because they are not considered to be 
“live, vertebrate animals” until hatching (NIH, 2009; 
Matthews and Varga, 2012), which occurs around 72 hpf.  
Regardless, proper euthanasia protocol should be used 
when discarding embryos; this requires submersion in ice 

water (0-4C) for at least 20 minutes, followed by addition 
of bleach to the water at a concentration of 1:5.  Once 
embryos are exposed to the bleach solution for five 
minutes, they may be discarded.  Institutional restrictions 
should be followed regarding disposal of organisms 
containing recombinant DNA.  It should be noted that 
institutional requirements regarding zebrafish embryos may 
differ from those of the NIH.  Additionally, if adults are to be 
used for breeding, an IACUC protocol is required.  For 
examples, see ZIRC website (https://zebrafish.org/ 
documents/protocols.php). 
 

Labeling the zebrafish lateral line in vivo 
To study mitochondrial dynamics in vivo, neurons in the 
lateral line, as well as elsewhere in the fish, are labeled by 
green fluorescent protein (GFP) driven by the neuroD 

promoter (neuroD:EGFP) (Figure 2A-B) (Mo & Nicolson, 
2011).  NeuroD is an early transcription factor expressed in 
many differentiating neurons including the lateral line 
ganglia (Thomas et al., 2012).  GFP fills the cytoplasm in 
labeled neurons, making them clearly distinguishable from 
background.  The neuroD:EGFP DNA can be microinjected 
in plasmid form into one cell-stage embryos, in which case 
labeling is mosaic, or alternatively we can provide the 
stable transgenic line Tg(neuroD:EGFP) upon request 
(Obholzer et al., 2008; also available from ZIRC).  
Mitochondria are labeled via a separate DNA construct, 
neuroD:mito-TagRFP (Figure 2A-B). This plasmid uses the 
neuroD promoter to drive expression of a fusion protein 
composed of a mitochondrial targeting sequence 
(Clontech) linked to a red fluorescent protein (TagRFP, 
available for purchase from Evrogen). The neuroD:mito-
TagRFP plasmid was assembled using Tol2 Multisite 
Gateway cloning from Invitrogen (Kwan et al. 2007; 
Obholzer et al. 2008; Drerup and Nechiporuk, unpublished 
observations).  This plasmid is introduced via 
microinjection into one-cell stage embryos.  If using the 
Tg(neuroD:EGFP) stable line, only the neuroD:mito-
TagRFP plasmid needs to be injected; if using wild-type 
zebrafish, both the neuroD:mito-TagRFP and 
neuroD:EGFP plasmids can be injected together. 
 

neuroD EGFP pA 

neuroD pA TagRFP mito 

A 

B 
mitochondrion axon cytoplasm 

 
Figure 2.  Labeling the lateral line in living zebrafish.  A. Two DNA 

constructs are available that label the lateral line neurons with a 
cytoplasmic enhanced green fluorescent protein (EGFP; upper 
construct), and label mitochondria within lateral line neurons with 
a tagged form of TagRFP that localizes to the mitochondrial 
membrane (lower construct).  Both constructs are driven by the 
neuroD promoter.  B. Expression in a lateral line axon appears as 
red punctate mitochondria in the context of GFP-labeled 
cytoplasm (green).  Trafficking of mitochondria is imaged in living 
fish. 

 
     Before the lab session, fish should be screened for 
expression of GFP and mitoTagRFP in the lateral line.  
Screening is most easily done in the GFP channel (green 
filter), either using a fluorescence dissection microscope (if 
available), or wide-field epifluorescence system.  While the 
GFP expression should be visible at low magnification, 
mito-TagRFP expression in mitochondria is punctate 
(Figure 2B) and only visible at higher magnification (e.g., 
20X).  If both constructs have been co-injected together, 
GFP expression can be used as an indicator of both 
constructs, since both likely express in the same cells.  
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During screening, it is useful to categorize fish into those 
that express on the left side versus the right (not necessary 
for Tg(neuroD:EGFP) fish, which will express on both 
sides).  This can aid students when mounting; however, if 
large numbers of fish are mounted there are good odds 
that expression will be visible without this added L/R 
screening step.  Using the Tg(neuroD:EGFP) fish will help 
facilitate screening and lower the number of injected 
plasmids from two to one.  In-crosses are advisable with 
this heterozygous line (i.e., heterozygous crossed to 
heterozygous) to generate expression in roughly 75% of 
embryos (25% homozygous + 50% heterozygous 
offspring).  For efficiency purposes, microinjection and 
screening are typically done ‘behind the scenes’ by our 
instructional staff; however, students are invited to our 
zebrafish facility outside of the lab session if they wish to 
learn the microinjection technique.  Microinjection is a 
powerful technique that can be learned over several weeks 
by students or technicians if desired (described in detail in 
Westerfield, 2000; Rosen et al., 2009).  Instructors and 
support staff are encouraged to inject a large excess of 
embryos to ensure attainment of an adequate number of 
expressing embryos. 
 
EQUIPMENT NEEDED 

 Microinjection equipment (e.g., pipette puller, 

micromanipulator, pressure source, etc.) if constructs to 

be injected in-house 

 Dissection microscopes with transillumination (1-2 per 

student group) 

 Digital heat block (for low-melt agarose if used for 

mounting fish) 

 Upright or inverted fluorescence compound microscope, 

equipped with standard green (FITC/Alexa488/GFP) 

and red (TRITC/Alexa555/mCherry) filter sets, and 

monochromatic digital camera (color camera also 

suitable but not needed), for imaging of embryos. 

 Basic image acquisition software that allows for time-

lapse capture (e.g., AxioVision, SPOT) 

 Computers (Mac or PC) equipped with ImageJ or  FIJI 

(students can use personal laptops as software is open 

access) 

 Optional - fluorescence dissection microscope (for 

embryo screening) 

 

REAGENTS NEEDED 

 E3 Embryo Medium (Recipe from Nüsslein-Volhard and 

Dahm, 2002): 5mM NaCl, 0.17mM KCl, 0.33mM CaCl2, 

0.33mM MgSO4, 10
-5 

% Methylene Blue.  For 1L of 60x 

stock, dissolve 17.2g NaCl, 0.76g KCl, 2.9g 

CaCl22H2O, and 4.9g MgSO47H2O in 1L of DI or RO 

H2O.  Add Methylene Blue when making 1X solution.) 

 Low-melt agarose for mounting live embryos (Amresco; 

J234) 

 Anesthetic: Ethyl 3-aminobenzoate methanesulfonate 

salt (MESAB/Tricaine/MS-222; Fluka A5040) – store on 

ice.  Stock of 4 mg/mL; add approx. 0.25-0.5 mL (~5-10 

drops) to 3 mL E3 medium (~half full 35 mm Petri dish); 

~(0.33-0.66mg/mL final concentration). 

 N-Phenylthiourea [PTU] (Alfa-Aesar: CAS 103-85-5); 
Starting at 24 hpf, this may be added to E3 medium at 
0.003% if desired to inhibit pigmentation.  (Note: PTU is 
considered hazardous by the Occupational Safety and 
Health Administration, OSHA.) 

 
ADDITIONAL MATERIALS FOR EACH LAB GROUP 

 For Step 1: Embryo manipulation tool (numerous design 
options) 

 For Step 1: Needle syringes (optional, for 
dechorionation; ~0.45 mm gauge)  

 For Steps 1-2: Petri dishes (100mm x 15mm for embryo 
storage; 60mm x 15mm for dechorionation, anatomy; 
35mm x10mm for anesthetization) 

 For Steps 1-2: 1-2 disposable transfer pipettes, or 
Pasteur pipettes with bulb or pump 

 For Step 2: Fine-tipped transfer pipettes may be desired 
for agarose mounting 

 For Steps 2-4: Glass slides (for upright microscopes) or 
small petri dishes with coverslip bottoms (for inverted 
microscopes)  

 For Step 2: No 1.5 coverslips (66x22mm to coverslip 
fish for air objective; 22x22mm for bridge mounting 
method; or similar sizes – e.g., see Figure 3).  

 

RESULTS 
 

LABORATORY PROCEDURES 
 

Step 1. Fish handling & anatomy  
Students begin by inspecting fish at different ages using a 
dissection microscope with transillumination.  We provide 
fish at ~1, 2, and 5 dpf for comparison.  Although these 
recommended ages are flexible, it is useful for students to 
become accustomed to the ages they will use for their 
experiments (1-2 dpf), and it is also useful to compare 
these young developmental stages with a slightly older 
fish.  They will become familiar with anatomical landmarks 
(e.g., ear, heart) and should note various age-related 
differences, such as the lack of yolk and presence of swim 
bladder at later stages.  Online zebrafish atlases or 
published resources can be used to aid students in this 
activity (e.g., Kimmel et al., 1995).  We have developed a 
worksheet that requires the students to make various 
measurements, including heart rate (available at 
weissmanlab.com).  Our laboratory clusters students into 
lab groups of three. 
     Students then practice manually removing the chorion 
from the fish after viewing online videos of the procedure 
(e.g., JoVE; https://www.youtube.com/watch?v= sDUuMwn 
HRFM).  We have the students use two needle syringes as 
tools for this process.  Some students struggle with 
dechorionation, either in terms of their fine motor control 
and/or because they have psychological issues with 
harming the fish.  While this step can be skipped (i.e., if 
embryos are provided to students dechorionated), teaching 
the students to dechorionate their own fish allows them to 
be more independent later in the semester.  Students then 
learn to anesthetize their dechorionated fish by adding 
Tricaine (MESAB; see Reagents) directly to the dish and 
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waiting for the startle response to disappear upon light 
touch to embryo with manipulation tool. 
     We spend one three-hour lab session on fish handling 
and anatomy, allowing students to maximize time in the 
subsequent lab session on the microscopes.  Alternatively, 
however, some students could begin shifts at the 
fluorescence microscope during the first session (perhaps 
with pre-prepared slides) while other students are focusing 
on anatomy and handling. 

 

glass coverslip 

AIR 

objective 

WATER 

objective 

agarose 

glass coverslip 

OIL 

objective 

- oil - 

agarose 

objective 

A B 

C D 

 
Figure 3.  Mounting options.  Living fish must be mounted in a 
water-soluble environment on the slide.  A. For inverted 
microscopes, place fish onto a coverslip (e.g., bottom of cover-
slipped petri dish), and cover with low-melt agarose followed by 
E3 medium.  B. With upright water objective, fish can be mounted 

in low-melt agarose with no coverslip.  Place fish as close to the 
surface of agarose as possible.  C. With upright air objective, fish 

should be mounted in E3 medium (or fish system water) and 
cover-slipped using some type of ‘bridge’ method to protect fish 
from being squashed.  D. Oil objectives are not recommended 
due to their short working distance, but they may work if the 
lateral surface of the fish abuts the coverslip.  More detailed 
mounting instructions are useful for students, and are available at 
weissmanlab.com. 
 
Step 2. Mount fish onto slides 
Mounting fish onto glass slides for imaging is one of the 
more difficult tasks for students in this project.  There are 
many different options for mounting, and the ideal method 
depends upon which objectives are available at the 
microscope.  Since the fish are alive during the imaging 
session, they must be in a water-soluble environment on 
the slide (in either E3 embryo medium or agarose made 
with E3).  Both upright and inverted microscope systems 
are appropriate.  Since the lateral line is close to the 
surface of the skin, one need not focus far into the 
organism to capture images.  An inverted microscope is 
thus appropriate (Figure 3A) if the fish is placed onto a 
coverslip (e.g., bottom of coverslipped petri dish), and 
covered with low-melt agarose for stability, followed by E3 

medium or fish system water for hydration (see Reagents).  
If an upright microscope with a water objective is being 
used, fish can be mounted directly onto slides in agarose 
with no coverslip (Figure 3B).  The fish should be placed 
close to the surface of the agarose, to minimize optical 
aberrations, and a water column should be present 
between the agarose bed and the objective.  (Use either 
E3 or de-chlorinated water; distilled water typically contains 
chlorine.)  If an upright microscope with a dry air objective 
is being used, fish should be placed in E3 embryo medium 
on the slide, then cover-slipped (Figure 3C).  It is crucial to 
build a supportive structure on the slide so that the 
coverslip does not flatten the fish.  This can be made from 
a number of readily available items, such as small 
coverslips stacked on either end of the slide, or vacuum 
grease dotted on the four corners of slide surface.  
Depression slides may be used and cover-slipped directly, 
but the fish may sit too low in the well to be captured within 
the working distance of the objective.  Oil objectives are 
not recommended due to their typically short working 
distances, but could potentially work in either upright or 
inverted systems if the side of the fish abuts the coverslip 
(e.g., Figure 3D).  If desired, fish may also be mounted 
between two large coverslips in order to image from both 
top and bottom.  Additional detailed mounting instructions 
and handouts are available at weissmanlab.com. 
     Regardless of the mounting approach selected, several 
anesthetized fish should be mounted together onto one 
slide in order to increase the likelihood of finding at least 
one unobstructed, well-labeled lateral line axon in a fish 
that is sitting at the appropriate angle.  At 1-2 dpf, the yolk 
protrudes ventrally from the fish trunk, conveniently and 
naturally turning the fish onto its side when placed on the 
glass.  This is the ideal angle for viewing the lateral line.  
Great care should be taken when manipulating the fish, 
however, as to not disturb/rupture the yolk, which is sticky 
and pervasive, and can contribute significantly to optical 
aberrations during imaging.  Fish will remain healthy during 
the imaging session for up to several hours.  (If the yolk is 
ruptured, fish will not survive.)  Following the imaging 
session, fish should be removed and euthanized/discarded 
appropriately (see Background section of Materials and 
Methods above). 

 
Step 3. Live imaging of zebrafish at 1 dpf 
Students should first use a low-powered objective (e.g., 
5X) to locate a fish on the slide. This step can be 
somewhat tricky for students because zebrafish are 
transparent; it may be helpful for them to use the GFP 
channel as opposed to transmitted white light to locate the 
fish.  Next, center on the trunk of one fish (Figure 4A) by 
moving the slide/microscope stage in X and Y directions 
until the trunk region is in the very center of the viewable 
field.  Then, switching to a higher magnification (e.g. 20X), 
locate the lateral line axon/s in the GFP channel (Figure 
4B-C).  These axons will appear long, smooth, and 
relatively thick, projecting along the side of fish, quite 
superficially (just under the skin).  It should be relatively 
easy to distinguish the lateral line axons from the deeper 
spinal cord neurons, which are narrower in caliber and 
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slightly more dorsal than the lateral line (Figure 4B).  Once 
the lateral line is identified, scroll in the rostral/caudal 
direction until a region is found that is contained in one 
focal plane (filling most of the field).  Although searching 
may take some time for students, they should be 
encouraged to work relatively quickly, since overexposure 
may bleach the fluorophores.  Multiple axons may be 
labeled with neuroD:EGFP, especially if the transgenic line 
is used. 
 

GFP 

mito-TagRFP 

GFP A 
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B GFP 

eye 

fb 

yolk 

B 

ganglion 

spinal cord 

 
Figure 4.  Lateral line labeling in a living 2 dpf zebrafish.  A. Here, 

the neuroD-EGFP construct labels the lateral line ganglion behind 
the fish ear and at least one lateral line axon (arrowheads), as 
well as neurons in the developing eye and forebrain (fb).  Fish 
imaged from the lateral view using a 10X air objective (montage 
of six fields).  B. Box from A is shown magnified.  Neurons in the 

spinal cord (upper part of image) are deeper into the tissue than 
the superficial lateral line axon, but both depths are shown for 
demonstration purposes in this confocal 3-D projection.  The 
lateral line axon is thicker in caliber, smooth, and more superficial, 
making it distinct from axons in the spinal cord.  C. Lateral line 
axons viewed using a wide-field epifluorescence microscope (40X 
water objective).  D. Mitochondria are shown within an axon from 
(C).  While multiple lateral line axons may visible in the GFP 

channel, especially if the Tg(neuroD:EGFP transgenic line is 
used, mito-TagRFP ideally expresses in only a subset of axons.  
Scale bars: 500 um in A; 100 um in B; 50 um in C & D. 

 

     Once a relatively flat region (e.g., Figure 4C) is 
identified, the experiment is almost complete.  Take a quick 
image of the axon/s in the green channel if desired (not 

necessary for analysis, but useful for presentation 
purposes).  Now switch to the red channel to visualize 
mitochondria, which should appear as tiny spots along the 
axon (Figure 4D).  Ideally the mitochondria within only one 
axon have been labeled, even if multiple axons were 
visible in the green channel.  After focusing on the punctate 
mitochondria and adjusting exposure appropriately, set up 
the acquisition software to collect a short time-lapse movie 
in the red channel only.  Length of the movie should be 
approximately 1-2 minutes long, with a time interval of 
approximately 1-2 seconds between frames.  (Time 
intervals longer than 1-2 seconds will be too slow to 
capture quick mitochondrial movements.)  Save the time-
lapse data in a format that will be recognized by ImageJ 
(e.g., tiff series, .zvi, .oib, .lif, etc.), and be sure to record 
the time interval between frames.  A quick preview of the 
movie should reveal mitochondria moving along the axon, 
likely in both directions.  Ideally one axon is visually distinct 
from neighboring axons within the lateral line (e.g., Figure 
4B,D); imaging labeled mitochondria in two neighboring 
axons may complicate the analysis.  Students can 
complete a thorough analysis even if they are able to 
acquire only one or two movies, as long as some mobile 
mitochondria can be identified.  The kymographic analysis 
can be done on poorly resolved (e.g., blurry) mitochondria, 
because the center of the object can be followed over 
distances.  Furthermore, since the acquired time-lapse 
series can be quite short (~60 seconds), even microscopes 
without an automated shutter can be used.  (Simply leave 
the shutter open for the duration of the acquisition.)  Slight 
decreases in mitochondrial intensity (e.g., due to 
bleaching) will not drastically affect the kymographic 
analysis. 
     An additional option at this stage, while the fish is still 
on the microscope (especially if mitochondria are not 
labeled or visualized well), is to locate and image the tips 
of the GFP-labeled lateral line axon growth cone, which is 
still growing until ~36 hpf.  Switching now to the GFP 
channel, a longer time-lapse movie can be acquired 
(approximately 5-10 minutes total (or more if desired/able), 
with time interval of approximately 10-20 seconds between 
frames).  Even short movies should reveal growth cone 
dynamics for visualization by students. 
     The major bottleneck with this research module comes 
at the microscope, since resources are limited and there 
are typically five to eight different groups (based on a class 
size of 15-24) who need to rotate through imaging stations.  
This bottleneck can be improved by increasing the number 
of lab sessions/weeks dedicated to imaging.  We schedule 
four 3-hour imaging sessions (on 3-4 usable fluorescence 
microscopes), with 1.5 hour shifts at each imaging station.  
During each lab session, students may have a number of 
goals, including anatomical study of live fish (see Step 1), 
mastery of kymograph preparation (on sample movies), 
and subsequent analysis of their own data (see Step 5). 
 
Step 4.  (Optional) Live imaging of zebrafish at 2 dpf 
To expand the inquiry-based aspect of this project, we ask 
students to compare mitochondrial dynamics between 
younger and older fish.  At ~24 hours, the lateral line axons 
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are still growing/extending along the rostro-caudal axis.  At 
36-48 hours, the period of extension is complete.  By 
including additional imaging sessions at the later 
developmental stage, students can put together a more 
independent and creative analysis of their results, 
comparing a still-growing axon with one that has already 
reached its target and is undergoing synapse formation.  
Methods are identical to Step 3, but using older embryos 
(which can be slightly easier to mount).  Student groups 
will differ in their efficiency at imaging.  In imaging sessions 
2-4, we provide both ages of fish so that students can 
focus where needed. 
 
Step 5. Analysis 
Once the students have collected time-lapse images of 
mitochondria in the lateral line at 1dpf (and/or 2dpf), they 
can analyze the velocity and movements of individual 
mitochondria using kymograph analysis in ImageJ or FIJI.  
This software, as well as the plugins required for the 
kymographic analysis, are freely available online for instant 
download, and can be used on either Mac or PC platforms.  
In addition to installing ImageJ, students will need to 
download two additional plugins: Bio-formats Package 
(http://downloads.openmicroscopy.org/bio-formats/5.1.0/) 
and the Kymograph Plugin (http://www.embl.de/eamnet/ 
html/body_kymograph.html).  Step-by-step instructions for 
this analysis, in the form of a lab handout, are available at 
weissmanlab.com. 
     Using the Bio-formats importer in ImageJ, students will 
first open a time-lapse image series that is in a 
recognizable file format (e.g., tiff series, .zvi, .oib, .lif, etc.).  
In an abbreviated module, or if students are not successful 
in obtaining their own images, students can perform 
kymographic analyses on image series provided by the 
instructor or other lab groups.  (We will be providing some 
of these resources on our lab webpage: 
weissmanlab.com.)  Upon opening an image file, the 
options for “Standard ImageJ” and “Autoscale” should be 
selected.  Once the image series is opened, students 
should be able to move through the time-lapse series with 
a scroll bar at the bottom of the image file.  The size of the 
image file should be noted (in microns or pixels; often 
located in the top left corner of image) for later calculating 
distance and velocity.  (If the image size is unknown, it can 
be calculated by imaging a micrometer with the same 
objective.)  It is useful to then duplicate the image in order 
to run multiple analyses (Image>Duplicate, select 
“Duplicate Stack”). 
     Students should select a region of the axon that is in 
focus throughout the time series and that shows at least 
one mitochondrion moving (Figure 5A).  To simplify the 
view, they may select a small portion of the image using 
the rotate (Image>Transform>Rotate) and crop 
(Image>Crop) tools.  Students should keep track of the 
orientation of the selected axon with respect to the 
anterior/posterior axis of the fish; this will be important for 
comparing retrograde versus anterograde mitochondrial 
transport. 

     Students can then draw a segmented line along the 

axon by right clicking on the line tool (Figure 5A).  The use 

of the segmented line tool allows students to trace axons 

that may bend slightly over their length.  From this line, 

they will generate a kymograph using the kymograph 

plugin (Plugin>Multiple Kymograph), which will prompt to 

select a line width.  The students can experiment with 

which line width works best to create the cleanest 

kymograph, but we suggest starting with width = 1 first and 

working up by odd numbers.  If movement has occurred 

during the time-lapse collection, it can be corrected using a 

freely available ImageJ plugin called “StackReg”. 
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Figure 5.  Sample time-lapse images with kymograph.  A. Four 

single time points are shown at 10, 54, 96, and 180 seconds.  (In 
ImageJ, sequential images appear as an image stack.)  
Arrowhead tracks a single mitochondrion, which moves toward 
left over time.  Using the ImageJ tools, a segmented line is drawn 
along the axon of interest (shown at 10 sec).  ImageJ measures 
the fluorescence intensity at each pixel along that line.  B. A 

kymograph is generated that displays the fluorescence intensity 
present along the segmented line (x-axis) over time (downward 
on y-axis).  The first time frame of the time-lapse movie is shown 
as the very top horizontal row of pixels; the last frame is shown in 
the bottom pixel row (see text).  Arrowheads in (B) correspond to 
same object moving toward left in movie above.  Asterisks in (A) 
and (B) follow a stationary object.  Diagonal lines in kymograph 
demonstrate moving objects over time; vertical lines illustrate 
stationary objects.  The ImageJ plugin measures velocity 
(distance/time) from straight lines drawn on kymograph. 
 

     At this point, students should have generated a 

kymograph (e.g., Figure 5B).  It is crucial that the students 

understand how to interpret these graphs.  In a kymograph, 

the top horizontal row of pixels displays the intensity values 

along the length of the segmented line at the first time 

point.  If a bright mitochondrion is present at the first time 

point of the movie (e.g., Figure 5A, top), then in the 
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kymograph, bright pixels should appear at that same x 

location in the very top row (Figure 5B).  The x-axis simply 

maps distance along the segmented line (i.e., the length of 

the axon).  The next row of pixels down in the kymograph 

shows the intensity values along the same segmented line 

but now at the next time point, and so on down the y-axis, 

which displays time progressing downward.  The 

kymograph thus shows imaged fluorescence along the 

length of the segmented line (x-axis) over time (y-axis 

downward).  Fluorescent objects (e.g., mitochondria) that 

are present throughout a portion of the movie should 

appear along the vertical dimension of the kymograph that 

corresponds to those time points.  The location along the x-

axis will represent an object’s specific location at each 

point in time.  Since an object is typically present over a 

period of time, it will appear as a white line going 

downward on the graph.  While an object is stationary, its 

location along the x-axis should not change over time, thus 

it should appear as a vertical line (asterisks in Figure 5A-

B).  While an object is in motion, its x location changes 

over time, thus it can be tracked as a diagonal line going 

downward on the kymograph (arrowheads in Figure 5A-B).  

This type of graphic display is extremely useful for directly 

calculating various aspects of object movement, including 

velocity, distance traveled, direction traveled, number of 

starts and stops, length of bout, etc.  If students save their 

kymograph image, it can be included in their manuscript or 

presentation later. 
     The velocity of moving objects can be calculated from 
the kymograph using the ‘tsp’ tool  (Plugins>Macros> 
Install>tsp050607).  Using the straight line tool, students 
will draw a straight line over a diagonal region on the 
kymograph, starting at the earlier time points (toward top) 
and ending with the later time points toward the bottom of 
the image, as shown in Figure 5.  Each bout of movement 
(diagonal section, possibly interrupted by a brief still period, 
which would appear vertical) should be analyzed 
separately.  Note that even blurry mitochondria can be 
analyzed; students will simply track the centroid of the 
fuzzy line.  To generate a velocity value for each segment, 
select Plugins>Macros>”read velocities from tsp.” 
     Students can copy and paste each reading into a 
spreadsheet program such as Microsoft Excel to keep 
track of velocity values for multiple mitochondria.  
Anterograde and retrograde direction of movement (either 
down toward left or down toward right) should be recorded 
at this step.  The value “dy sum” corresponds to change in 
y (time), and “dx sum” corresponds to change in x 
(distance).  Note that these values are reported as number 
of frames (time) and pixels (distance), respectively.  Before 
calculating the actual velocity (dx/dy), however, values 
need to be converted into seconds and microns.  To 
convert the reported time values from number of frames to 
seconds, simply divide by the number frames per second.  
(This value was set by user during image acquisition.)  
Note that if students used a line width greater than one, dy 
will have been multiplied by that factor.  Next, to convert 
distance values from pixels to microns, students must 
multiply each value by the appropriate number of microns 

per pixel.  These pixel dimensions can be viewed under 
Image>Show Info (may be reported as “Resolution”).  If 
such metadata is not available, students will at least be 
able to read the number of pixels across the width of the 
image.  They can then capture a new image of a 
micrometer using the same objective on the same 
microscope.  Knowing the distance between ticks on the 
micrometer, students can calculate the approximate 
number of microns across their image, then divide this by 
the pixel width.  If the instructors wish to simplify this step 
for students, they can pre-calculate the pixel dimensions 
for each objective; however, this tedious calculation is 
effective in helping students understand how they actually 
calculate velocity from their images. 
     There are multiple ways for students to analyze the 
measurements they acquire from the kymograph analysis, 
depending upon the questions they wish to answer.  For 
example, they could compare average mitochondrial 
velocities across different ages of fish, compare retrograde 
and anterograde mitochondrial transport (Figure 6A), or 
calculate the number of bouts per minute and/or the length 
of each bout (which reflects attachment to or detachment 
from motor proteins.) 
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Figure 6.  Examples of student work.  A. Boxplots compare 

mitochondrial transport velocity in the retrograde (ret) and 
anterograde (ant) directions, at 1 and 2 dpf.  B. In this 
independent project, students compared growth cone morphology 
and dynamics in the developing lateral line of living zebrafish 
embryos at 1 and 2 dpf that had been exposed to 3% ethanol or 
control.  These students also tested the escape response in the 
same fish (data not shown). 
 

Step 6.  Independent projects 
Once they have completed the basic module (Steps 1-5), 
students are capable of repeating these experiments on 



The Journal of Undergraduate Neuroscience Education (JUNE), Summer 2015, 13(3):A215-A224     A223 
 

their own.  They are typically eager to select any number of 
manipulations or ideas for expanding their research 
question.  For example, they may wish to look at the same 
two time points in the presence of a pharmacological 
agent, in a mutant zebrafish line, or in fish housed within a 
different environment.  They may wish to analyze a new 
time point, or simply repeat the experiment to increase 
sample size and power in their analysis.  Alternatively, they 
may wish to focus on growth cone dynamics (Figure 6B).  
Depending upon the preferences of the instructional staff, 
students may be given a great deal of freedom on the 
design of their project, or they may be asked to design new 
experiments that focus on a particular manipulation (e.g., 
calcium dynamics). 
     In our course, after submitting a structured proposal for 
their independent work and receiving feedback/approval 
from the instructor, students are encouraged to work 
independently (both inside and outside of class time) on 
their projects.  Assistance is typically required in obtaining 
(and diluting) necessary reagents, timing injections of 
constructs, and microscopy.  While students are con-
sistently able to generate satisfying data during the 
independent project portion of the semester, they often 
report that they could use more time for their independent 
work, even when they are given a full five weeks. 
 
Step 7.  Presenting their work 
There are numerous options for presentation and 
assessment.  In our course, for Steps 3-5, student groups 
write a scientific manuscript with Introduction, Methods, 
Results, Discussion, and References Sections (worth 40 
points out of 150 total for lab).  They are requested to 
design and include at least three different figures (not 
tables, and not simply raw data) that summarize and 
visually display various aspects of their data (e.g., Figure 
6A).  For the independent projects, a written project 
proposal (15 points) is required that includes a statement 
of the specific question to be addressed, hypothesis to be 
tested, description of approach/techniques, proposed 
schedule, and list of required supplies and animals/ages.  
Following completion of the independent projects, students 
present their work in an oral presentation (Powerpoint 
style), and must include background, methods, detailed 
results, analysis, future ideas, and literature cited.  All 
presentations are given on a final lab day, and are worth 
40 points (out of 150 total for lab).  A scaled-down version 
of this lab could require a basic worksheet from the 
kymographic analysis that asks students to report 
mitochondrial velocity in anterograde vs. retrograde 
directions, number of bouts per minute, etc. 
     Steps 1-7 can be modular in that they need not all be 
done.  We provide two sample schedules in Table 1 (full 
length version) and Table 2 (abbreviated version). 
 

DISCUSSION 
We present here an open-ended research project 
appropriate for advanced undergraduates who wish to 
investigate axonal development in the zebrafish lateral line 
system.  Students learn multiple useful skills, including 
working with living fish, in vivo time-lapse fluorescence  
 

Week 1 Zebrafish 
development & 
anatomy 

Project overview.  Practice 
dechorionating, anesthetizing, 
basic fish anatomy, mounting, 
etc. 

Week 2 Fluorescence 
microscopy 

Overview of fluorescence 
microscopy.  Practice mounting 
fish & using fluorescence 
microscope. 

Week 3 In vivo time-
lapse session 1 

Introduction should be 
complete by now (lateral line, 
axonal transport, etc.).  Groups 
screen & mount fish, begin 
time-lapse at first time point 
(~24 hpf) 

Week 4 In vivo time-

lapse session 2 
+ analysis 

Continue imaging.  Fish also 
available at ~36 hpf for some 
groups.  Data analysis can 
begin. 

Week 5 In vivo time-

lapse session 3 
+ analysis 

Continue imaging.  Each group 
should have 3-4 good quality 
time-lapse series at each time 
point.  Data analysis ongoing. 

Week 6 In vivo time-

lapse session 4 
+ analysis 

Some groups finish up imaging.  
Most groups focus on data 
analysis.  Results summary & 
proposal for independent 
projects due in Week 7. 

Weeks 
7-10 (+) 

Independent 
projects (At least 
four dedicated 
weeks – more is 
better for 
students) 

Fish available at various time 
points throughout week, de-
pending upon student needs.  
Students work largely 
independently and often meet 
outside of lab time, but may 
utilize instructor help during 
regular lab sessions. 

Week 11 Final presentations 

 

Table 1.  Sample schedule I (full length version) 

 
Weeks 
1-2 

Zebrafish 
overview & in 
vivo time-

lapse imaging 
sessions 

Skip anatomy & dechorionation.  
Students simply mount fish & 
collect time-lapse for one age only 
(24 or 36 hpf).  Imaging is heavily 
supervised.  Time needed for all 
groups to image will depend on 
microscope bottleneck/equipment 
available.  While waiting for 
imaging stations, students can 
work on sample movie analysis. 

Weeks 
2-3 

Data analysis Work on generating and analyzing 
kymographs 

 

Table 2.  Sample schedule II (abbreviated version) 

 
microscopy, and, importantly, experimental design and 
quantitative analysis.  The project is modular in that it 
works either in full-length form, or with only a subset of 
steps (Tables 1-2).  Although the imaging portion of the 
project benefits from multiple fluorescence microscopes on 
hand, it can be done with only one basic wide-field 
epifluorescence microscope, or could even be done by 
analyzing movies acquired at a different facility. 
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     We have incorporated into this research project an 
advanced quantitative analysis of movement known as the 
kymograph.  Kymographic analysis is a quantitative 
approach that graphs movement over time.  It is rare that 
students have an opportunity to perform this type of 
analysis on data that they have generated through their 
own in vivo experiments.  Here, students are surprised to 
learn how accessible the approach is.  They often report 
feeling empowered by this concrete mathematical 
approach, which helps them envision new ways to 
visualize and communicate their scientific results. 
     Importantly, since little is known about the specific 
changes that occur in mitochondrial trafficking dynamics 
during lateral line development, students learn to design 
experiments and interpret data that investigate an open-
ended research question that does not have a clear 
answer in the lab manual.  The 2011 report on the Initiative 
for Vision and Change in Undergraduate Biology Education 
(AAAS, 2011) highlighted the critical need for an 
integration of the scientific process into undergraduate 
Biology courses.  Real research experiences that practice 
inquiry-based learning are foundational for providing 
students with an understanding of how to do science and 
how to understand the scientific process (Sadler and 
McKinney, 2010), and such experiences can be provided 
within the context of regular laboratory courses.  We have 
worked to develop this open-ended research project for an 
undergraduate neurobiology laboratory course that allows 
students to design and ask their own research question in 
developmental neurobiology, learn cutting-edge imaging 
techniques in an in vivo zebrafish model system, and 
master a broadly applicable quantitative approach for 
analyzing and presenting their data.  This project has the 
added advantage of investigating a relatively undiscovered 
area of neuroscience research.  Because of this, students 
interpret open-ended data sets and think like true 
researchers.  
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